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Note:  Our intent is that you try this problem on your own first.  After you have solved it on your
own, you can step through our solution if desired.  If you have problems trying to create the
model, then follow the steps in our solution.

Problem O
Isolated Building - Nonlinear Time History Analysis

Roof

2nd
1st

30’ 30’

30’
30’

12
’

12
’

Steel
E =29000 ksi, Poissons Ratio = 0.3
Beams:  W24X55;    Columns:  W14X90

Rubber Isolator Properties
Vertical (axial) stiffness = 10,000 k/in (linear)
Initial shear stiffness in each direction = 10 k/in
Shear yield force in each direction = 5 kips
Ratio of post yield shear stiffness to initial shear stiffness = 0.2

Vertical Loading and Mass
Roof: 75 psf DL                   Floor:125 psf DL

20 psf LL                   100 psf LL

Time History
Apply LP-TH0 in the X-direction and LP-TH90 in the Y-direction simultaneously. 
Each timehistory is given in units of g.  There are 2000 timesteps, at an equal
spacing of 0.02 sec, for a total of 40 sec.  There are 5 accelerations points per
line.

To Do
Plot time histories of Y-direction displacement at the 1st level and at the roof 
level.   Plot a time history of the 1st level Y-direction displacement versus the 
Y-direction base shear.

6” thick concrete
slab at roof

10” thick concrete
slab at 1st and
2nd floors

Note:  Provide diaphragm
constraint at each level to
make all diaphragms rigid.
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Problem O Solution

1. Click the drop down box in the status bar to change the units to kip-ft.

2. From the File menu select New Model From Template…. This displays the Model
Templates dialog box.

3. In this dialog box click on the Space Frame template button                      to display the
Space Frame dialog box.

4. In this dialog box:

• Type 2 in the Number of Bays Along X edit box.

• Type 30 in the Bay Width Along X edit box.

• Type 30 in the Bay Width Along Y edit box.

• Uncheck the Restraints check box.

• Accept the rest of the default values.

• Click the OK  button.

5. Click in the window labeled X-Y Plane @ Z=24 to make sure it is active.  The window is
active when its title is highlighted.

6. Click the Quick Draw Rectangular Shell Element button        on the side toolbar.

7. Click once in each of the four quadrants in the plan view to input four shell elements.

8. Click the Down One Gridline button        to move the plan display down to the X-Y Plane
@ Z=12.

9. Click once in each of the four quadrants in the plan view to input four shell elements.

10. Click the Down One Gridline button        to move the plan display down to the X-Y Plane
@ Z=0.

11. From the Draw menu select Draw NLLink Element .

12. In the plan view of the X-Y Plane @ Z=0 double click on each of the nine joints to draw
nine NLLink elements.

13. Click the Pointer button         to exit draw mode and enter select mode.

14. Click the drop down box in the status bar to change the units to kip-in.
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15. From the Define menu select Materials... to display the Define Materials dialog box.
Highlight the STEEL material and click the Modify/Show Material button to display the
Material Property Data dialog box.

16. In this dialog box:

• Verify that the modulus of elasticity is 29000 and poisson’s ratio is 0.3.

• Click the OK button twice to exit the dialog boxes.

17. From the Define menu select Frame Sections... to display the Define Frame Sections
dialog box.

18. In the Click To area, click the drop-down box that says Import I/Wide Flange and then
click on the Import I/Wide Flange item.

19. If the Section Property File dialog box appears then locate the Sections.pro file which
should be located in the same directory as the SAP2000 program files.

20. A dialog box appears with a list of all wide flange sections in the database.  In this dialog
box:

• Scroll down and click on the W24X55 section.

• Scroll down to the W14X90 section, and click on it while holding down the Ctrl key on
the keyboard.

• Click the OK button three times to exit all dialog boxes.

21. From the Define menu select Shell Sections... to display the Define Shell Sections dialog
box.

22. In this dialog box:

• Click the Add New Section button to display the Shell Sections dialog box.

• In this dialog box:

À Type ROOF in the Section Name edit box.

À Accept the default CONC material

À Type 6 in the Membrane edit box.

À Type 6 in the Bending edit box.

À In the Type area verify that the Shell option is selected.

À Click the OK button to return to the Define Shell Sections dialog box.
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• Click the Add New Section button to display the Shell Sections dialog box.

• In this dialog box:

À Type FLOOR in the Section Name edit box.

À Accept the default CONC material

À Type 10 in the Membrane edit box.

À Type 10 in the Bending edit box.

À In the Type area verify that the Shell option is selected.

À Click the OK button twice to exit all dialog boxes.

23. From the Define menu select NLLink Properties... to display the Define NLLink
Properties dialog box.

24. In this dialog box:

• Click the Modify/Show Property button to display the NLLink Property Data dialog
box.

• In this dialog box:

À Select Isolator1 from the Type drop-down box.

À Type .001 in the Mass edit box.

À Check the U1 Direction check box.

À Click the Modify/Show For U1 button to display the NLLink Directional
Properties dialog box.

À In this dialog box:

ä Type 10000 in the Effective Stiffness edit box.

ä Click the OK button to return to the NLLink Property Data dialog box.

À Check the U2 Direction check box.

À Check the U2 Nonlinear check box.

À Click the Modify/Show For U2 button to display the NLLink Directional
Properties dialog box.

À In this dialog box:
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ä In the Linear Properties area type 1.5 in the Effective Stiffness edit box.

ä In the Nonlinear Properties area type 10 in the Stiffness edit box.

ä Type 5 in the Yield Strength edit box.

ä Type .2 in the Post Yield Stiffness Ratio edit box.

ä Accept the rest of the default values.

ä Click the OK button to return to the NLLink Property Data dialog box.

À Check the U3 Direction check box.

À Check the U3 Nonlinear check box.

À Click the Modify/Show For U3 button to display the NLLink Directional
Properties dialog box.

À In this dialog box:

ä In the Linear Properties area type 1.5 in the Effective Stiffness edit box.

ä In the Nonlinear Properties area type 10 in the Stiffness edit box.

ä Type 5 in the Yield Strength edit box.

ä Type .2 in the Post Yield Stiffness Ratio edit box.

ä Accept the rest of the default values.

ä Click the OK button three times to exit all dialog boxes.

25. Click the drop down box in the status bar to change the units to kip-ft.

26. From the Define menu select Materials... to display the Define Materials dialog box.
Highlight the CONC material and click the Modify/Show Section button to display the
Material Property Data dialog box.

27. In this dialog box:

• Verify that the mass per unit volume is 4.657E-03 and that the weight per unit volume
is 0.15.

• Click the OK button twice to exit the dialog boxes.

28. Click in the window labeled X-Y Plane @ Z=0 to make sure it is active.

29. Click the xz 2D View button       on the main toolbar.
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30. Click the Perspective Toggle button        on the main toolbar.

31. Click the Set Intersecting Line select Mode button       on the side toolbar and select all of
the bottom level columns.

Note:  To use the Intersecting Line Selection option, click the Set Intersecting Line Select
Mode button       on the side tool bar.  Then click the left mouse button to the left of the
first level columns, and while holding down the left mouse button drag the mouse to the
right of the first level columns.  A “rubberband line” will appear and all elements that
this “rubberband line” passes through will be selected.  Release the left mouse button
to make the selection.

32. Click the Set Intersecting Line select Mode button       on the side toolbar and select all of
the top level columns.

33. From the Assign menu select Frame and then Sections... from the submenu to display the
Define Frame Sections dialog box.

34. In this dialog box:

• Click on W14X90 in the Frame Sections area to highlight it.

• Click the OK button.

35. Click the Show Undeformed Shape button        to remove the displayed frame element
assignments.

36. Click the xy 2D View button       on the main toolbar.  The plan view of the X-Y Plane @
Z=0 appears.

37. Click the Up One Gridline button        to move the plan display up to the X-Y Plane @
Z=12.

38. Select all of the elements at this level by “windowing”.

39. Click the Up One Gridline button        to move the plan display up to the X-Y Plane @
Z=24.

40. Select all of the elements at this level by “windowing”.

41. From the Assign menu select Frame and then Sections... from the submenu to display the
Define Frame Sections dialog box.

42. In this dialog box:

• Click on W24X55 in the Frame Sections area to highlight it.

• Click the OK button.
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43. Click the Show Undeformed Shape button        to remove the displayed frame element
assignments.

44. Select all of the elements at the Z=24 level by “windowing”.

45. From the Assign menu select Shell and then Sections... from the submenu to display the
Define Shell Sections dialog box.

46. In this dialog box:

• Click on ROOF in the Shell Sections area to highlight it.

• Click the OK button.

47. Click the Down One Gridline button        to move the plan display down to the X-Y Plane
@ Z=12.

48. Select all of the elements at this level by “windowing”.

49. From the Assign menu select Shell and then Sections... from the submenu to display the
Define Shell Sections dialog box.

50. In this dialog box:

• Click on FLOOR in the Shell Sections area to highlight it.

• Click the OK button.

51. From the Define menu select Static Load Cases... to display the Define Static Load Case
Names dialog box.

52. In this dialog box:

• Type DL in the Load edit box.

• Click the Change Load button.

• Type LL in the Load edit box.

• Select LIVE from the Type drop-down box.

• Type 0 in the Self Weight Multiplier edit box.

• Click the Add New Load button.

• Click the OK button.

53. Click the drop down box in the status bar to change the units to lb-ft.
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54. Select all of the elements at the Z=12 level by “windowing”.

55. From the Assign menu select Shell Static Loads… and then Uniform...  from the submenu
to display the Shell Uniform Loads dialog box.

56. In this dialog box:

• Select LL from the Load Case Name drop-down box.

• Type -100 in the Load edit box.

• Click the OK  button.

57. Click the Up One Gridline button        to move the plan display up to the X-Y Plane @
Z=24.

58. Select all of the elements at the Z=24 level by “windowing”.

59. From the Assign menu select Shell Static Loads… and then Uniform...  from the submenu
to display the Shell Uniform Loads dialog box.

60. In this dialog box:

• Type -20 in the Load edit box.

• Click the OK  button.

61. Click the drop down box in the status bar to change the units to kip-ft.

62. Click the Show Undeformed Shape button        to remove the displayed shell load
assignments.

63. Click the Down One Gridline button        to move the plan display down to the X-Y Plane
@ Z=12.

64. Select all of the elements at the Z=12 level by “windowing”.

65. From the Edit menu select Replicate… to display the Replicate dialog box.

66. In this dialog box:

• Select the Linear Tab.

• Type -12 in the Z Distance edit box.

• Type 1 in the Number edit box.

• Click the OK  button.
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Note:  Prior to defining time history functions, you should locate the time history files
named Lp-th0 and Lp-th90 that are in the subdirectory named Examples beneath the
directory where you installed SAP2000.  Copy these files into the same directory as
your SAP2000 input file.

If the Examples subdirectory does not exist you may need to reinstall SAP2000, and
select to install the examples.

67. From the Define menu select Time History Functions...  to display the Define Time
History Functions dialog box.

68. In this dialog box:

• Click the Add Function From File button to display the Time History Function
Definition dialog box.

• In this dialog box:

À Type LPTH0 in the Function Name edit box.

À Click the Open File button to display the Pick Function Data File dialog box.

À In this dialog box:

ä Locate and highlight the file named LP-TH0

ä Click the Open button to return to the Time History Function Definition dialog
box.

ä Type 5 in the Number Of Points Per Line edit box.

ä Select the Function At Equal Time Step option.

ä Type .02 in the Function At Equal Time Step edit box.

ä Click the OK button to return to the Define Time History Functions dialog box.

• Click the Add Function From File button to display the Time History Function
Definition dialog box.

• In this dialog box:

À Type LPTH90 in the Function Name edit box.

À Click the Open File button to display the Pick Function Data File dialog box.

À In this dialog box:

ä Locate and highlight the file named LP-TH90.
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ä Click the Open button to return to the Time History Function Definition dialog
box.

ä Type 5 in the Number Of Points Per Line edit box.

ä Select the Function At Equal Time Step option.

ä Type .02 in the Function At Equal Time Step edit box.

ä Click the OK button twice to exit all dialog boxes.

69. From the Analyze menu select Set Options... to display the Analysis Options dialog box.

• Check the Dynamic Analysis check box, if it is not already checked.

• Click the Set Dynamic Parameters button to display the Dynamic Analysis
Parameters dialog box.

• In this dialog box:

À Type 30 in the Number of Modes edit box.

À In the Type Of Analysis area select the Ritz Vectors option.

À Verify that ACCEL X, ACCEL Y and ACCEL Z are in the Ritz Load Vectors box
in the Starting Ritz Vectors area.

À Confirm that the Include NLLink Vectors box is checked.

À Click the OK button twice to exit all dialog boxes.

70. From the Define menu select Time History Cases...  to display the Define Time History
Cases dialog box.

71. In this dialog box:

• Click the Add New History button to display the Time History Case Data dialog box.

• In this dialog box:

À Type GRAV in the History Case Name edit box.

À Select Nonlinear from the Analysis Type drop-down box.

À Click the Modify/Show button for modal damping to display the Modal Damping
dialog box.

À In this dialog box:
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ä Type .05 in the Damping For All Modes edit box.

ä Click the OK button.

À Type 100 in the Number of Output Time Steps edit box.

À Type .1 in the Output Time Step Size edit box.

À Check the Envelopes check box.

À In the Load drop-down box, select DL.

À In the Function drop-down box, select RAMP.

À Type 1 in the Scale Factor edit box.

À Click the Add button.

À Click the OK button to return to the Define Time History Cases dialog box.

• Click the Add New History button to display the Time History Case Data dialog box.

• In this dialog box:

À Type LP in the History Case Name edit box.

À Select Nonlinear from the Analysis Type drop-down box.

À Click the Modify/Show button for modal damping to display the Modal Damping
dialog box.

À In this dialog box:

ä Type .05 in the Damping For All Modes edit box.

ä In the Modal Damping Overrides area type Type 1 in the Mode box, type 0.02
in the Damping box and click the Add button.

ä In the Modal Damping Overrides area type Type 2 in the Mode box and click
the Add button.

ä In the Modal Damping Overrides area type Type 3 in the Mode box and click
the Add button.

ä Click the OK button.

À Type 2000 in the Number of Output Time Steps edit box.

À Type .02 in the Output Time Step Size edit box.
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À In the Start From Previous History drop-down box select GRAV.

À Check the Envelopes check box.

À In the Load drop-down box, select acc dir 1.

À In the Function drop-down box, select LPTH0.

À Type 32.2 in the Scale Factor edit box.

À Click the Add button.

À In the Load drop-down box, select acc dir 2.

À In the Function drop-down box, select LPTH90.

À Click the Add button.

À Click the OK button twice to exit all dialog boxes.

72. Click in the window labeled X-Y Plane @ Z=12 to make sure it is active.

73. Click the Up One Gridline button        to move the plan display up to the X-Y Plane @
Z=24.

74. Select all elements at the Z=24 level by “windowing”.

75. From the Assign menu select Joint and then Constraints... from the submenu to display
the Constraints dialog box.

76. In this dialog box:

• Click the drop-down box in the Click To area, and click Add Diaphragm to display the
Diaphragm Constraint dialog box.

• In this dialog box:

À Type ROOF in the Constraint Name edit box.

À Select the Z axis option in the Constraint Axis area if it is not already selected.

À Click the OK button twice to assign the diaphragm constraint.

77. Click the Down One Gridline button        to move the plan display down to the X-Y Plane
@ Z=12.

78. Select all elements at the Z=12 level by “windowing”.
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79. From the Assign menu select Joint and then Constraints... from the submenu to display
the Constraints dialog box.

80. In this dialog box:

• Click the drop-down box in the Click To area, and click Add Diaphragm to display the
Diaphragm Constraint dialog box.

• In this dialog box:

À Type 2ND in the Constraint Name edit box.

À Select the Z axis option in the Constraint Axis area if it is not already selected.

À Click the OK button twice to assign the diaphragm constraint.

81. Click the Down One Gridline button        to move the plan display down to the X-Y Plane
@ Z=0.

82. Select all elements at the Z=0 level by “windowing”.

83. From the Assign menu select Joint and then Constraints... from the submenu to display
the Constraints dialog box.

84. In this dialog box:

• Click the drop-down box in the Click To area, and click Add Diaphragm to display the
Diaphragm Constraint dialog box.

• In this dialog box:

À Type 1ST in the Constraint Name edit box.

À Select the Z axis option in the Constraint Axis area if it is not already selected.

À Click the OK button twice to assign the diaphragm constraint.

85. Click the Show Undeformed Shape button        to remove the displayed diaphragm
constraint assignments.

86. Click the Run Analysis button       to run the analysis.

Note:  The analysis would run even quicker if we had not requested envelopes in the time
history case data.

87. When the analysis is complete check the messages in the Analysis window (there should be
no warnings or errors).  Click the OK button to close the Analysis window.

88. Click in the window labeled X-Y Plane @ Z=0 to make sure it is active.
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89. Click the Set Elements button        on the main toolbar (or select Set Elements… from the
View menu) to display the Set Elements Dialog box.

90. In this dialog box:

• Check the Labels box in the Joints area.

• Click the OK  button.

91. Click on the center joint, joint 13, in the plan at Z=0 to select it.

92. Click the Up One Gridline button        twice to move the plan display up to the X-Y Plane
@ Z=24.

93. Click on the center joint, joint 15, in the plan at Z=24 to select it.

94. Click the Set Elements button        on the main toolbar (or select Set Elements… from the
View menu) to display the Set Elements Dialog box.

95. In this dialog box:

• Uncheck the Labels box in the Joints area.

• Click the OK  button.

96. From the Display menu select Show Time History Traces… to display the Time History
Display Definition dialog box.

97. In this dialog box:

• Click the Define Functions button to display the Time History Functions dialog box.

• In this dialog box:

À Highlight Joint 13.

À Click the Modify/Show TH Function button to display the Time History Joint
Function dialog box.

À In this dialog box:

ä Verify that the Displ option is selected in the Vector Type area.

ä Select the UY option is selected in the Component area.

ä Click the OK  button to return to the Time History Functions dialog box.

À Highlight Joint 15.
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À Click the Modify/Show TH Function button to display the Time History Joint
Function dialog box.

À In this dialog box:

ä Verify that the Displ option is selected in the Vector Type area.

ä Select the UY option is selected in the Component area.

ä Click the OK button to return to the Time History Functions dialog box.

À In the Click To area select Add Base Functions from the drop-down box to display
the Base Functions dialog box.

À In this dialog box:

ä Check the Base Shear Y check box.

ä Click the OK button twice to return to the Time History Display Definition
dialog box.

• Select LP from The Time History Case drop-down box.

• Click on Joint 13 in the List of Functions to highlight (select) it.

• Hold down the Ctrl key on the keyboard and click on Joint 15 to add it to the selection.

• Click the Add button to move Joints 13 and 15 into the Plot Functions list.

• Click the Display button to display the displacement time histories.  Note that there is
very little difference between the 1st and roof level displacements.  The structure is
essentially moving as a rigid body on top of the isolators.

• Click the OK button to close the time history display and return to the Time History
Display Definition dialog box.

• Click the F(t) vs F(t) tab.

• Select Joint 13 from the Horizontal drop-down box.

• Select Base Shear Y from the Vertical drop-down box.

• Click the Display button to display the force-displacement plot.

• Click the OK button to close the Time History Functions display and return to the Time
History Display Definition dialog box.

• Click the Done button to close the Time History Display Definition dialog box.


